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SUMMARY 
We invite you to read the manual of the 

ScopeDome Arduino card driver. You 

will learn how the driver works, what 

are its most important functions, how 

to use it and how to configure it for 

optimal and stable operation. 
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What is the ScopeDome Arduino Driver for 

ScopeDome Arduino Driver is a Windows program that allows you to control and automate the 

operation of astronomical observatories controlled by ScopeDome Arduino cards. 

Its main functions are: controlling the rotation of the dome, opening and closing the shutter, 

synchronizing the position of the dome and the telescope. In addition, it enables the automatic 

closing of the dome shutter in the event of various emergency situations, e.g. power failure, 

rainfall or loss of Internet connection. 

The driver with the ScopeDome Arduino card allows you to control the operation of various types 

of observatories, from RollOffRoof, through typical domes with one or two shutters, to Clamshell 

domes. This is done by appropriate programming of the control card and selecting the 

appropriate settings in the program. One control card is enough to control the Clamshell dome 

and RollOffRoof observatory. Two cards are needed to control the rotation motorized 

astronomical domes and the shutter. The first one controls the rotation of the dome, the second 

controls the movement of the shutter via a radio link. 

The driver also allows you to control the heating of the dome motors, enclosures containing the 

control electronics of the observatory, two telescope mirrors (or other elements requiring 

heating) and a rain and cloud sensor. 

The driver can connect to popular weather stations, the AllSky camera, a cloud and rain sensor, 

the SQM sky quality meter and read data from them. 

Notation used in the user's manual 

The program has many configuration options. To recall a specific option or item in the manual, we 

use the notation: Window>Tab>GroupBox>Element Name 

For example: Main>Dome State> Dome Radar recalls Dome Radar in the main program window. 

 

Principle of operation of the dome driver 

After starting the program, it connects to the card and starts reading its status periodically. From 

the level of the user interface in the program, the ASCOM platform, or the driver's internal 

procedures, commands are sent to the card, e.g. to turn to a given position, open a shutter or 

switch on a relay. All commands are asynchronously queued and then sent one by one for 

execution to the card. Pressing the "STOP" button stops the execution of the last command and 

clears the entire queue. 

It should be remembered that the card and driver work independently and asynchronously - 

which may lead to incomprehensible at first glance software or dome behavior. 

The driver can also execute commands that operate periodically, for example: if the options "Sync 

with Scope" or "Sync with Wind" are enabled, they constantly set (synchronize) the position of 

the dome depending on the current position of the telescope or the wind direction. Turning on 

"Sync With Sky" will cause the dome to make one turn every 24 hours. 

The card and the driver can independently of each other and automatically close the shutter in 

emergency situations. We can configure the card so that if the input "Cloud Sensor", "Rain 

Sensor", "No Power" or "Low UPS Battery" is activated, the shutter of the observatory will close 

automatically. Please note that this will happen even when the observatory control computer is 

turned off. Additionally, when the driver is running on the control computer, the shutter can be 

closed automatically: after losing Internet connection, in bad weather conditions, at a given time 



  
Str: 4 

or when the shutter is open for too long. 

 

Note: Due to the fact that the card closes the shutter without the computer assistance, the 

command to close it will not be displayed in the driver's window. The shutter will just close.  

You can also specify conditions necessary to open or close the shutter such as: parking the 

telescope from the ASCOM level, active “Park telescope” input on the card, no rain, clouds or 

good weather condition. This can be useful when controlling the observatory with programs such 

as CCD Commander or ACP. 

The logic condition „Weather>Weather Condition Info>Good Weather”  is calculated as follows: 

Not (Cloud OR Cloudy OR Rain OR (Wind Speed> Hi Wind Speed)). Therefore, if any of these 

conditions are present, the Good Weather condition will not be met, which will prevent the dome 

from opening. 

 

Regardless of the functions being processed, the driver or the card supports thermostats that 

allow to maintain a constant temperature of motors, electronics housings, or heating of the cloud 

and rain sensor. It also stores the necessary information in files, cloud sensor statistics, and 

photos from the AllSky camera, if configured on the system. 

If you change anything in the program configuration, remember to save these changes and restart 

the driver. If the changes may alter the card configuration, remember to send them to the card by 

pressing the button „Card>Send config to Card”.  

 

Note: Never change more than one parameter at a time. This usually leads to software 

problems. Change one parameter and test what results are. If everything works as expected, 

save them. If you are not sure about the new settings, go back to the old ones loading the last 

saved configuration of the card. If you are completely lost, start with the default card settings 

and press the "Restore Default" button. 
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Security built into the driver 

The driver has built-in protection against incorrect operation of the dome position encoder and 

limit switches that limit the shutter movements. 

The driver does not allow to exceed the encoder counter value of the dome position defined in 

„Config>Card>Card Configuration>Encoder Max Value/ Encoder Min Value”. If the next 

operation of the dome rotation causes the maximum or minimum value of the encoder counter 

to be exceeded, it will not be executed or the dome will start to rotate in the opposite direction - 

it will perform a movement analogous to the so called Telescope Pier Flip. 

If the counter is exceeded due to the inertia of the dome mass, the driver will only allow the 

movement in the opposite direction (decreasing the value of the encoder counter). 

Manual control of the dome (from the buttons on the card's panel) in CW or CCW directions will 

work all the time. Rotating the dome out of the encoder counter range will be disabled. 

If the encoder range is exceeded - the easiest and fastest solution is to manually guide the dome 

to the Home sensor and reset the dome encoder counter using the button Config>Card>Dome 

Counters and encoder calib.> Reset Encoder ENC = 0.  

 

You can also reset the encoder counter „Main>Dome commands>GoTo” by selecting an Derotate 

option from the drop-down list, which will start turning the dome towards the encoder value of 0. 

The driver always checks if the dome position encoder is working properly. For this purpose, it 

measures whether the counter value has changed by the selected number of pulses in a given 

time. This is determined by the parameters: 

a) Config>Dome>Dome Rotate>Min counter delta  

b) Config>Dome> Dome Rotate>Time to check  

 
For standard settings, during the rotation of the dome, the encoder counter must change the 

value by 1 within 5 seconds. If it does not do it, the dome motor will be stopped and a program 

error will be reported with the message "Dome Rotate Too Slow". 
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The driver checks the movement of the shutter on two levels: 

1) after the opening or closing command has been issued, it is checked whether the state of the 

appropriate limit switch of the shutter has changed in a given time. 

2) the total time of opening or closing the shutter is checked. 

 

This is determined by the parameters: 

a) Config>Shutter>Shutter Movment Limits>Start delay (waiting for a status change of the 

shutter limit switch) 

b) Config>Shutter>Shutter Movment Limits>Max opening time (waiting for the shutter to open 

completely) 

 
If the event expected by the driver does not occur within the set time, the shutter motor will be 

stopped. 

 

 

Quick Help  

This is an automatically appearing window with hints and short description of driver’s functions. 

When you hover the mouse cursor over any element, short hints and explanations of the program 

functions will be displayed. 

 

 

To enable it, check the box: Config>Program>Program>Quick Help. 
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Installation of the driver 

The description of the installation procedure can be found in the file: 

c:\ScopeDome\Doc\Software_installation_instructions_EN - 5.5.5.18.pdf. 

The program can be installed on a PC with the Windows operating system, version XP or newer. To 

work properly, the program requires the installation of the ASCOM platform in version 6.4 or 6.5 and 

the .Net environment in version 3.51 or newer. 

Note: Before installing the new version, it is necessary to uninstall the older version of the driver. 

Before uninstalling the driver, you can save its configuration to a file using the button: 

Config>Program>Save/Load Config to File>Save 

After installing the new version, you can load saved configuration using the button: 

Config>Program>Save/Load Config to File>Load  

 

The settings are saved by default in a file C:\ScopeDome\ScopeDome_Config.ini 

Note: ASCOM 6.5 installer does not install POTH and HUB by default. If you intend to use them to 

connect to a telescope, select this components when installing the ASCOM 6.5 platform. 

Basic tests of the operation of the driver and the dome's driving mechanisms 

Note: The driver requires that all dome components (control card, dome motors, limit switches, 

home sensor, encoder, telescope) work properly. After assembling the dome and installing the 

software, check their operation. 

If, after reading this manual, you still do not know what to do or the card does not work properly, 

please contact us by email with a description of the problems. We will try to verify the problem as 

soon as possible. In order to enable remote diagnostics, please install or run the current 

TeamViewer version and connect a webcam, which will allow us to see what your dome, 

telescope, power supply, etc. looks like. A typical service session takes about 2 hours. 

First steps of driver configuration 

After installation, the driver starts in the 3M dome simulator mode. To complete configuration 

of driver and connect it physically to the card, follow the steps below: 

1. Select the type of the dome:  

- parameter Config> Card>Card and Dome Type>Dome Type 

2. Select the type of the card:  

- parameter Config> Card>Card and Dome Type>Card Type 

 
3. Save the settings (this is very important - thanks to this the driver knows how to restore the 

default settings): 

- button Config> Card>Save Settings 

4. Restore default settings:  

- button Config> Card>Card and Dome Type>Restore Default 
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5. Choose how to connect to the card (by Ethernet or USB):  

- parameter Config> Card>ScopeDome Arduino Card>Connect by 

6. Enter IP or COM port number:  

- parameter Config> Card>ScopeDome Arduino Card>Ip Address: 

- or parameter Config> Card>ScopeDome Arduino Card>Com Port 

 

 
7. Save the settings again (from now on the driver knows how to connect to your card): 

- button Config>Save Settings 

8. Send settings to card: 

- button Config>Card and Dome Type>Send config to card 

9. Close Config window and main program window by clicking Exit. 

10. Wait a few seconds and restart the driver. 

 

After restarting, the driver should connect to the observatory control card. Connection errors 

are displayed in the window: ScopeDome LS>Main>Command Monitor. If connection has 

been made successfully, the command monitor window will remain blank. Otherwise, you will 

get messages about connection error: 

 

The driver will use the standard configuration typical for the selected dome type. Standard 

configuration files for all types of domes are stored in the directory: 

c:\ScopeDome\ _Def_Config_Files and should not be changed. 
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Test of computer connection with the card 

The easiest way is to check the proper operation of connection between the card and computer is to 

test the function of "Telescope" or "CCD" relays. After pressing the relay control button on the card, 

the appropriate icon should change its state in the driver window and the relay should switch on. 

Before pressing the Telescope button: 

 

After pressing the Telescope button: 

 

Connection errors are displayed in the Command Monitor window: 

 

Note: If the window is empty after starting the driver, it means that the driver has correctly 

connected to the card or is working in the dome simulator mode. 

Determining the position of the Home Sensor and how it works 

The proper operation of the Dome Home Sensor is crucial for the functioning of the driver. It sets the 

initial (zero) position of the dome and on this basis the position of the dome during its rotation is 

determined. 

 

When Home Sensor is active, the dome position encoder counter must be zero. It is a good idea to 

verify the encoder counter value from time to time and reset it if necessary. The current counter value 

is presented on the status line (bottom bar) of the main program panel (Enc: 0): 

 

 
 

If the Home Sensor is not positioned to the south (the shutter points then to the north), then its 

position should be entered as parameter in filed Config>Dome>Dome Geometry> Home Sensor 

Position You can enter this angle manually or calculate it using the Set button: 
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Using the Set button 

a) turn the dome to AtHome position (e.g. by  ScopeDome LS>Main>Goto> Find Home) 

b) reset the dome position counter (button Config>Card>Dome Counters and encoder calib.> Reset 

Encoder ENC = 0) 

c) rotate the dome - so that the center of the shutter points exactly to the North direction 

d) press button Config>Dome>Dome Geometry> Home Sensor Position>Set 

 

Home Sensor operation can also be checked manually. 

To do this, just insert a sheet of paper into the sensor gap and observe the main driver window. After 

covering the sensor, the driver should display a red text AtHome: 

 
Various sensors of the dome's "home" position can be connected to the card. They can return one or 

zero logic signal when the sensor is active (e.g. old ScopeDome Home Sensors, or reed switches). The 

driver allows you to negate the value returned by the sensor. The marker is used for this: 

Config>Card>Card Configuration> Negative Home Sensor . Selecting it will invert the signal from the 

Home Sensor. 

 

Be sure to save the settings after changing this parameter (button Config>Card>Save Settings), then 

send them to the card (using button Config>Card>Send config to card) and restart the driver. 

 

AtHome label in the driver window should be displayed only when the Home Sensor is obscured 

(active). 

If the Negative Home Sensor parameter is incorrectly set - this inscription always appears and 

disappears when the Home sensor is active (covered). 

 

Note: The Home Sensor is sensitive to sunlight. A sensor illuminated by direct sunlight may not 

function properly. Cobwebs or dust are equally dangerous - from time to time you should clean the 

Home Sensor and the photodiode with compressed air or a clean, lint-free cloth. 

 

The operation of the Home Sensor depends on the position of the diaphragm (a metal, flexible plate 

screwed to the rear panel of the dome), it is necessary to ensure that the diaphragm has the 

appropriate length and position. It must stable and effectively cover the photodiode inside the sensor 

during the rotation of the dome. The pictures below show the correct setting of the diaphragm when 

AtHome position: 

 

 
 

Examples of Home Sensor and diaphragm settings can be found in the file: 

Doc/Home Sensor Adjustment.pdf 
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Dome position encoder operation check 

This is a very important component that determines the operation of the driver and the accuracy of 

the dome positioning. While the dome is moving, the "Encoder" diode on the card panel should blink 

(go on and off). 

 

Incorrect alignment of the optical sensor with the encoder wheel mounted on the motor axis can 

cause unstable or erroneous dome position readings. In such a situation, the encoder pulses may not 

even be counted at all and the driver reports the error "Dome rotate too slow", even though the dome 

is rotating. 

 

The easiest way to check the operation of the encoder is in the AtHome position of the dome. 

To do this: 

a) set the dome in the AtHome position (AtHome sensor must be active) 

b) reset dome position counter (ENC=0) (button Config>Card>Dome Counters and encoder calib.> 

Reset Encoder ENC = 0) 

c) using function ScopeDome LS>Main>Dome commands>ENC. GoTo turn the dome to position 200  

d) using function ScopeDome LS>Main>Dome commands>ENC. GoTo turn the dome back to position 

0 (zero) 

 

After these operations the dome should return to position Enc = 0 and the AtHome sensor should be 

active. If the dome returns to the AtHome position every time, the encoder is working properly. 

 

It is worth repeating these steps for different values  ScopeDome LS>Main>ENC. GoTo (e.g. 300, 500, -

200, -300, -500).  

 

If the encoder is not working properly, you should verify: 

a) if the dome drive gear wheel tightly coupled with the rack around the entire circumference of the 

dome. If necessary, adjust the position of the dome rotation motor, stopping the dome in this place. 

b) has the encoder wheel inside the housing come loose? For example: the bolt securing it to the axle 

has not loosened during transport or use and does the disc rotate with the axle of the gear. 

c) if the encoder wheel close to one of the edges of the optical sensor (normally it should be placed 

around 1/3 of the sensor aperture width) 

d) if the optical sensor of the encoder is dirty and needs cleaning 

e) if the encoder wires properly connected to the card  
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Checking the operation of the shutter limit switches 

The limit switches in ScopeDome have two functions: 

a) send the shutter status (open / close) to the driver, 
b) physically cut off the dome window motor control signal and stop it when activated. 
 

One pair of the limit switch contacts (NO - normal open) is used to transmit the signal of opening / 

closing the shutter, the second one (NC - normal close) is used to cut off the signal controlling the 

motor. 

Note: To check if the limit switches are working properly, first, using the buttons on the card, set the 

shutter so that it is half open. 

Checking the operation of the shutter closure sensor 

To do this, press the lever of the "Close" limit switch (simulating its activation by a pressure plate 

mounted on the shutter) and check the status of the shutter in the driver. 

Marker  ScopeDome LS> Shutters>Shutter 1> Close Sensor 1 should be active and after releasing 

the switch lever it should be deactivated: 

 

Proceed in the same way with the shutter opening sensor (located at the top of the dome). 

 

The Reset button is used to reset the counter of the shutter position. If the program shows the 

wrong angle ("Degree" value) when opening or closing the shutter, reset the counter of the 

shutter position after the shutter is closed. The next time the shutter is opened, the software will 

measure the necessary parameters and the next time the shutter is opened it should show the 

correct values. 

Checking the operation of cutting off the signals controlling the shutter motor 

Perform this test with the help of two people with the control software on the computer turned 

off. One of the people presses the Open or Close button on the card, and the other stops its 

operation activating the limit switch. After breaking the limit switch lever, the shutter should 

stop. 
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 Configuring the connection to the telescope 

In order to automatically synchronize the position of the dome with the position of the telescope, it is 

necessary to send to the driver information about its position, the "PierSide" parameter (on which side 

of the pier the telescope is located) and the geographical coordinates of the observatory. 

 

The driver works best with the telescope via the ASCOM platform. It is also possible to connect the 

telescope via TheSkyX, TheSky6, CartesDuCiel software or via an XML file. 

 

From the ASCOM platform it is best to connect to the telescope via a Hub component working in Local 

Server mode. The most common mistake made by users is to connect the telescope's ASCOM driver to 

two programs at once, e.g. to MaximDL and some sky atlas software. This usually causes the telescope 

driver to hang, and then the entire ASCOM platform, including the dome driver. To avoid such a 

situation, first connect the telescope's controller, e.g. to POTH Hub, and then configure POTH Hub as 

the telescope's driver in other programs, i.e. in MaximDL, TheSkyX and ScopeDomeDriver. 

 

Note: ASCOM platform ver. 6.5 does not install the POTH component by default, you must manually 

select the necessary options during the installation or configure the connection with the telescope 

via ASCOM Chooser>Device Hub. 

 

Example configuration for ASCOM 6.5 via Device HUB: 

 
It should be checked whether all the telescope control programs have the same geographical 

coordinates of the observatory. All programs communicating with the telescope must pass the same 

geographic coordinates of the telescope: 

 

The Get and Set buttons allow you to upload and download the observatory coordinates from the 

telescope driver, provided that the selected ASCOM driver performs this function. 
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„SideOfPier” parameter 

PierSide (or SideOfPier) is, after geographic coordinates, the most important parameter 

determining the correct synchronization of the dome's position with the telescope. Its value 

depends only on the mode of operation of the telescope's driver and each manufacturer can use 

their own way for correctly passing this parameter. Due to the fact that there is no formal 

standard and thus there is no one universal method of configuring this parameter. 

In the ScopeDome driver, several configuration options for this parameter are available at 

Config>Telescope>SideOfPier 

 
 

Usually, the Calculate SideOfPier option works best, but for some telescopes, Use SideOfPier 

from scope is a good choice. Usually, the Invers SideOfPier option should also be selected. 

 

The Use SideOfPier from scope option causes ScopeDome to read the SideOfPier parameter 

directly from the telescope controller. 

 

The Calculate SideOfPier option uses the ScopeDome driver's built-in algorithm to calculate the 

value of this parameter based on the telescope coordinates. However, it is worth remembering 

that it all depends on the initial position of the telescope on the east or west side. In this case, the 

Invers SideOfPier option can be helpful, which allows you to quickly invert its value. 

 

The Use SideOfPier form diagram option is the final choice if the options described above do not 

work. It allows you to define any SideOfPier value depending on which part of the sky the 

telescope is looking at. However, we do not recommend you to use this option. Its correct 

configuration could be very complicated. 

 

 
 

To find the correct setting for your telescope, experiment with different settings or talk to other 

SopeDome users who have a similar type of telescope to yours - they will certainly be able to 

suggest the best way of connection between the dome and the telescope. It should also be 

remembered that it is just as important as PierSide to correctly enter the X, Y, Z, GEM parameters 

and the coordinates of the observatory. If these parameters are entered incorrectly, the 

synchronization of the dome window with the telescope will not work properly. The key is the 

GEM parameter, which has the greatest impact on the synchronization of the dome with the 

telescope. 
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Selecting the method of reading the AtPark Telescope sensor 

 
- Option  “Telescope Driver AtPark Solution” 

The ScopeDome driver will use the AtPark function of the telescope driver to read the 

telescope's AtPark status. 

- Option  “Telescope Alt/Az Position” 

The ScopeDome driver will use the telescope's Alt/Az coordinates to read the AtPark 

state of the telescope. 

- Option  “ScopeDome Card Telescope AtPark Sensor” 

The ScopeDome driver will use the TelescopeAtPark input of the ScopeDome card to 

read the telescope's AtPark status. 

 Selecting how to park the telescope 

 
- Option  “Telescope Driver AtPark Solution” 

The ScopeDome driver for parking the telescope will use the Park function of the 

telescope driver. 

- Option  “Telescope Alt/Az Position” 

The ScopeDome driver for parking the telescope will use the telescope's GoTo Alt/Az 

function. 

 

The “Get Current Position” button fills the current telescope position with the Altitude and 

Azimuth parameters of the telescope coordinates - this allows you to quickly enter the 

telescope parking coordinates. 
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Example settings for TheSkyX, Paramont MYT, TEC140 in our observatory in Otivar - Spain 

It is interesting that in such a configuration only connection via the ASCOM driver (and not 

directly via TheSKyX) allows the correct synchronization of the telescope with the dome. We have 

been using this configuration for several months and we have not noticed any problems with 

working of the dome with the telescope. 

 

 

 

Configuration of dome geometry (X, Y, Z, GEM) and observatory coordinates 

The X, Y, Z Gem parameters determine the accuracy of the synchronization of the dome and 

telescope positions. The precisely measured parameters allow to achieve centimeter precision of 

the center of the dome's shutter in relation to the direction of the optical center of the telescope. 

Please note that the parameters X, Y, Z refer to the point of intersection of the telescope's RA and 

DEC axes, not the center of the pier. More information how to calculate these parameters can be 

found in the file: 

Doc/Dome Geometry - Additional Information.pdf 
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Turning on the card and the dome motors heating system 

The domes work in various weather conditions. Often, at night, when humidity is greater than 80% 

and temperatures drop below freezing. During humid nights, on electronics can deposit a moisture, 

causing short circuits, corrosion of paths on PCB and damage to electronic components. On the other 

hand, low temperatures thicken the lubricants in the engine gears, which makes it difficult to move 

the dome shutter. 

 

Note: To ensure trouble-free operation of electronics and motors, it is necessary to heat them 24 

hours a day. 

 

Settings for heating inside the enslousures, motors and related settings can be found in the tab: 

Config>Heating 

 

 
In the Temperature field, enter the desired temperature value of motors and electronics inside 

housings to be maintained, and then click the Enable button. Pressing the Disable button turns off the 

heating of motors and enclosures. 

 

The driver assumes that the electronics and motor heaters are connected to the card's REL4 and REL5 

relays, respectively. The temperature of the electronics is measured by the thermometer built into the 

card, the motor temperature is measured by the thermometer connected to the OW1 input. The 

motor thermometer should be screwed to the motor gear motor as far as possible from the motor 

heater. 
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Turning on the telescope mirror heating 

The mirror heating can be controlled in three ways: 

1. giving the fill (percentage of power) with which the selected heater is to work, and then press the 

button: ScopeDome LS>Relays>Dome Relays>Set 

 

 

2. giving in Config>Heating>Mirror 1/2 heating window the desired mirror temperature, and then 

press the Enable button: 

 

3. giving in Config>Heating>Mirror 1/2 heating  window the difference between the mirror 

temperature and the ambient temperature, then press the Enable button: 

 

The driver assumes that the telescope's mirrors (or lenses) are heated through the card's PWM 

outputs. You will find a connection diagram of heaters and thermometers in the manual for the card, 

on pages 14 and 15 (ScopeDome_Arduino_Card_Manual). The mirror heater number 1 should be 

connected to the PWM1 output, the mirror heater number 2 to the PWM2 output. The external 

temperature is measured by a thermometer connected to the OW2 input of the Shutter (Slave) card. 

Please note that the maximum current flowing through the heater is 2A at 12VDC (24W). Turning on 

the mirror heating will require an additional power of approx. 50W and replacement of the card's 

power supply with one that will handle the greater demand for power. 

Note: We suggest using a power supply with a minimum power of 100W. 

  

https://www.scopedome.com/wp-content/uploads/2020/10/ScopeDome_Arduino_Card_Manual_EN-1.pdf
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Configuration of connection with the weather station 

 

 

The driver has built-in support for many popular weather stations. Settings regarding the 

selection of the weather station to work with the program can be found in the tab: 

Config>Weather 

 

Data from the weather station are read from the log file saved by the weather station in CSV 

format in the computer's file system. The exceptions are "ASCOM Observing Hub", "ASCOM 

Open Weather Map" and "ScopeDome Cloud Sensor", which do not require a data exchange file 

(log). 

For stations of the "Weather Underground API" type, it is required to provide the WWW address 

of the link to the data from the station and enter your own API key for this data, e.g. 

https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&

apiKey=dcaca713088fa49c78a713088fa09c7a7 

where:  

NAME – the name of your weather station 

dcaca713088fa49c78a713088fa09c7a7 – your unique ApiKey 

 

The connection to the "Weather Underground API" can be tested by entering this address into the 

browser - in response you should receive a typical xml file with current data. Weather.com counts 

the number of data readings per hour and blocks access to the data if the readings are too 

frequent. We suggest reading the data no more than once every 5 minutes (parameter "Weather 

Scan Interval"). 

https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&apiKey=dcaca713088fa49c78a713088fa09c7a7
https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&apiKey=dcaca713088fa49c78a713088fa09c7a7
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Sample file format for a popular weather station (and also a cloud sensor) 

„AAG CloudWatcher”: 

"Date","Time","Cloud Condition","Rain Condition","Brightness Condition","Cloud Value","Cloud Sensor Temperature","Rain 

Value","Brightness Value","Ambient Temperature","Rain Heating Percentage","Rain Sensor Temperature","Heating Status","Switch 

Status","Read Cycle","Timeout Errors","Safe Status","Wind Condition","Wind Value","Rel hum Condition","RH Value" 

"2020-04-17","20:23:58","Cloudy","Dry","Dark","-

15.6","10.3","4544","2868","10.3","20%","18.0","","Closed","5","0","Unsafe","Windy","7.0","Dry","50%" 

To connect the weather station to the driver, select its type from the list in the field 

Config>Weather>Weather Station Config>Weather Station Type, then indicate the log file saved 

by the station in the field Config>Weather>Weather Station Config>Current Weather Data File 

Name, and then restart the driver. 

 

The problem is that weather station manufacturers often change the format of the station data 

log file. Additionally, the file format may also depend on the regional settings of Windows 

(characters used to separate numbers). This causes errors in reading data from the weather 

station data file. 

 

If you have difficulties connecting the weather station, please contact us. Usually we are able to 

help within a few days. Also, a remote service session may be necessary to sole the problem or 

you will need to send us your data log from the weather station and a link to its user manual. 

List of weather stations supported by the driver: 

1. ScopeDome Cloud Sensor 

2. Heavy Weather 

3. HeavyWeather PRO WS 2800 

4. Boltwood Cloud Sensor (from current date log - eq. 2020-02-26.txt) 

5. Boltwood Cloud Sensor (Single Line - New Format) 

6. AAG CloudWatcher 

7. Davis Vantage Pro 

8. Sirene 

9. Virtual Weather Station 

10. Sentinel Weather Station 

11. Cumulus 

12. Weather Display 

13. EMA 

14. Davis Ventage Vue (WeatherLink) 

15. EasyWeather v6.2 

16. ASCOM Observing Condition Hub 

17. ASCOM Open Weather Map 

18. WeatherLink 

19. SkyAlert 

20. Weater Underground API 
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Configuring the connection with the cloud sensor 

The configuration of the cloud sensor is the same as for the weather station. To connect a cloud 

sensor to a driver, select its type from the list in the field Config>Weather>Cloud Sensor 

Config>Cloud Sensor Station Type, then indicate the log file saved by the sensor in the field 

Config>Weather>Cloud Sensor Config>Current Cloud Sensor Status File Name, and then restart 

the driver. 

 
If the weather station has an integrated cloud sensor, it is enough to configure it only in the 

weather station section. 

Configurating the ScopeDome Cloud Sensor 

ScopeDome Cloud Sensor to work properly requires entering the difference between the 

ambient temperature and the sky temperature read by the "Out Termometer" and "Pirometer 

Sensor" respectively: 

 

The value of this parameter depends on how the Cloud Sensor is installed. It should be aimed 

so that only the sky above the observatory is within its field of view, in particular it should not 

include surrounding trees or buildings. 

For example, in Spain the optimal value seems to be -25 degrees. Entering an index equal to -

27 degrees - will result in greater sensitivity to high clouds. 

Note: After changing the "Cloud Index" parameter, it is necessary to save the settings ("Save 

Settings" button) and then send them to the card ("Send Config to Card" button). 

List of cloud sensors supported by the driver: 

1. ScopeDome Cloud Sensor 

2. Boltwood Cloud Sensor (from current date log - eq. 2020-02-26.txt) 

3. Boltwood Cloud Sensor (Single Line - New Format) 

4. AAG CloudWatcher 

5. EMA 

6. Tektite 

7. Virtual Weather Station 

8. ASCOM Observing Condition Hub 

9. ASCOM Open Weather Map 

10. SkyAlert 
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Configuring the connection to the Sky Quality Meter 

The way to configure the sky quality sensor (SQM) is the same as for the weather station or cloud 

sensor. 

List of Sky Quality Meters supported by the driver: 

1. SQM 

2. SQM Reader 2 

3. EMA 

4. ASCOM Observing Condition Hub 

5. ASCOM Open Weather Map 
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Configuration of the shutter emergency closing conditions 

 

This is one of the most difficult elements of the driver configuration. First of all, it is necessary to 

understand difference between "Card inputs events" and "Software events". 

"Card inputs events" are triggered by the corresponding card inputs and handled on the 

hardware level of the card. Which means that they will work always as long as the card has a 

power supply, regardless of whether the observatory's control computer is working at that time. 

 

"Software events" are generated by the driver and operated from the level of the driver running 

on the observatory's control computer. For their correct operation, the computer in the 

observatory must be turned on, connected to the card and its driver must be running. 

For example, the following entry means that the card will check the state of the "Cloud Sensor" 

input every 5 seconds and if this input is active three times in a row - the card will automatically 

start to close the shutter or the roof of the observatory. 

 

 

 

In other words, if the sensor is active three times in a row at 5-second intervals - the shutter will 

close. The time after which the shutter closes from the moment of activation of the "Cloud 

Sensor" input will be: 5s x 3clk = 15 seconds. 

Note: Never enter a value of zero in the read frequency (s) and number of occurrences (clk) 

fields. This will cause the driver to hang. 

 

If during this time (15s) the sensor input stops being active for a while, the card will start counting 

the active state from the beginning and the shutter will not close. This avoids unnecessary dome 

closures in unstable weather conditions. The same applies to the other inputs of the card, both 

hardware and software. 
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Description of the Card inputs events option 

• Cloud Sensor –closes the shutter when the input of the "Cloud Sensor" card is active 

• Rain Sensor –closes the shutter when the input of the "Rain Sensor" card is active 

• Cloudy (Pirometer Sensor) – closes the shutter when ScopeDome Cloud Sensor will 

detect cloudiness - the operation of this option depends on the parameter value 

Config>Weather >ScopeDome Cloud Sensor parameters>Cloud Index  

• No Power – closes the shutter when the card detects that 230V voltage is missing at the 

input of the "230V Sensor" card. This option is useful when the observatory is powered by 

UPS. The 230V sensor input should be connected before the UPS. If the UPS is not 

connected, this option will not work. The activation time of this sensor should be set in 

such a way that the UPS batteries allow the power supply to be maintained for the time 

necessary to close the observatory's shutter. 

• Low UPS Battery –  closes the shutter when the battery voltage in the UPS is too low. To 

use this option, connect the UPS's batteries to the "0-64 Voltage" input in accordance 

with the card manual (diagram on page 14) and enter the appropriate "Battery threshold" 

value. 

Description of the Software events option 

• Lost internet connection – checks if the computer is connected to the indicated IP 

address. The checking consists in periodically sending PING to the indicated IP address 

(e.g. router address in the local network 192.168.1.1) 

• Bad Weather – checks if Bad Weather input state is active 

• On Time –closes the shutter at the specified time 

• Shutter opened longer then – closes the shutter if it is open longer than the specified 

period of time 

• Enable IP Watchdog – selecting this option and sending the settings to the card will make 

the card itself (without the computer's participation) ping the indicated address and, in 

the event of no answer, it will close the shutter 

• Ip address for internet connection test – IP address used for Lost Internet Connection 

and IP Watchdog functions 

The Bad Weather option integrates the status of all weather sensors from both card inputs, 

weather stations and the cloud sensor. It will be active when one of the sensors detects 

clouds, rain or too strong wind. 

 

Set the maximum wind speed at which the dome can remain open, in the field 

Config>Weather>Hi Wind. The frequency of data readings from weather stations is set in the 

field Config>Weather>Weather Scan Interval: 

  

- parameter „Use Unsafe State from weather station log” allows you to read the Unsafe status 

from the cloud sensor or weather station log. The option is especially useful for AAG Cloud 

Sensor users. 
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Encoder counter reset 

 

For the correct synchronization of the dome and telescope positions and for closing the shutters, the 

driver requires that the "Home Sensor" sensor is active while the encoder counter equals to zero (Enc 

= 0). 

This is a very important function for users of 4M and 55M domes as well as other domes where the 

shutter card and drive is powered by power contacts operating only in the "At Home" position. 

Due to the mechanical play (inaccuracies) on the gears and gears of the dome's rotation motor, 

periodically check that when encoder counter equal to zero (Enc = 0), the dome stops in the place of 

the "Home Sensor". It is worth doing such a test even once a month. 

It also happens that the encoder counter in the "At Home" position has a value lower or higher than 

zero due to a hang of the card or computer controlling the dome. After this type of failure, always 

check the value of the encoder in the AtHome position. 

Manual encoder reset 

If we are in a dome, it is usually the fastest to reset the encoder counter manually. First, rotate 

the dome using the CW or CCW buttons on the card - so that the Home Sensor is active, then 

press the button Config>Card>Dome Counters and encoder calib.> Reset Encoder ENC = 0. It is 

worth paying attention to the position of the diaphragm covering the Home Sensor. It should 

be positioned in the center of the black sensor inside the Home Sensor housing (approximately 

one third of the width of the Home Sensor housing). 

Automatic finding of the encoder zero position 

  

If the dome's rotary drive is working properly and the Home Sensor is working reliable, we can 

use the Find Home function from the main driver screen. The dome will start to rotate until it 

hits the Home Sensor. 
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Encoder calibration 

The Calibrate Dome Encoder function is available in the tab Config>Card>Dome Counters and encoder 

calib. 

 

It allows you to check how many encoder pulses are counted per full turn of the dome. This feature will 

be especially useful for owners of domes from manufacturers other than ScopeDome. For ScopeDome, 

it is restored from the default values for the selected dome type. 

 

Note: The function will only work when the HomeSensor sensor is working - check its operation 

before starting. 

 

It is best to activate this function when the dome is in the "At Home" position - the At Home text on the 

driver's main panel must be shown in red color: 

 
 

After pressing the "Calibrate Dome Encoder" button, the dome will move a few degrees in the CW 

direction, then it will start turning CCW, waiting for the next two Home Sensor activations. The number 

of pulses counted between successive Home Sensor activations will be saved in the field  

Config>Card>Card configuration>Encoder value for 360. This value, together with the Home Sensor 

position, allows the dome shutter azimuth to be calculated in degrees. 
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Dome motor inertia calibration 

 
Function Config>Card>Dome Counters and encoder calib.>Calibrate Dome Motor Inertia is used to 

improve the accuracy of the function Main>GoTo i Main>Enc GoTo.  

Thanks to it, the driver can take into account the inertia mass of the dome. The domes are quite 

heavy, e.g. a 3M dome weighs around 200 kg, and a 55M dome over 1000 kg. It is not easy to set them 

in motion, and even more so to stop them in a selected place with an accuracy of one encoder pulse, 

which corresponds to about 2mm of the dome circumference. 

 

Thanks to this function, the dome will reach the given azimuth angle faster (without unnecessary 

position corrections). It is the similar to the backlash adjustment function known from telescope 

mounts. 

 

For this function to work properly, it is necessary to check the operation of the Encoder and Home 

Sensor beforehand. The dome must rotate smoothly and without jamming around its circumference, 

and the encoder must return the correct values. Activating this function is also a great test of the 

dome's rotating mechanism. 

 

After pressing the "Calibrate Dome Motor Inertia" button, the driver will perform 120 to 150 dome 

motion tests. This will take approximately 20 minutes. During the test, the driver will perform 

measurements as long as the number of encoder steps set by the EncGoTo function differs from the 

actual position reached by the dome, the measured results will be saved after the end of the test to 

the file ScopeDome_DomeInertia_Table.txt. 

 

Note: For ScopeDome 2M, 3M, 4M and 55M users, we have prepared typical files that are played 

back during driver configuration. So, as long as your domes are properly assembled, there is no need 

to follow this procedure. 

 

 Typical appearance of the program window during calibration 

 

 
If an error message appears in any of the following steps, you should manually change the 

content in the file: ScopeDome_DomeInertia_Table.txt  or repeat the entire calibration 

procedure. In case of problems, please contact us via email. 

You can also just delete the wrong file: ScopeDome_DomeInertia_Table.txt  and restart the 

driver. On the computer disk, in the c:\scopedome directory, a copy of the file from before the 

calibration procedure should be saved, it is enough to rename it to restore the previous values.  
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Description of the contents of log files saved by the driver 

Arduino_Commads_Log.txt  

• Logs all commands sent by the driver to the ScopeDome Adruino card except the 

GetStatus command. 

Arduino_Error_Log.txt  

• Logs low-level errors reported by the card. 

ScopeDomeCard_InternalSensors_Log.txt  

• Logs data on the values of all card inputs, saved every 30 seconds. 

Cloud_Statistic.log  

• Logs data from the sensor Cloud, records every 1 minute. 

ScopeDomeCard_Log.txt  

• Logs all operations from the user and from the ASCOM platform performed by the 

driver. 

ScopeDomeCard_Error_Log.txt  

• Logs high-level errors reported by the card. 

ScopeDomeCard_Log_ASCOM.txt  

• Logs the commands sent by the ASCOM platform to the driver. 

Config_Change_Log.txt 

• Logs configuration changes. 

Cloudy_Sensor_Status.txt 

• Shows the current state of the Cloudy input (ScopeDome Cloud Sensor state). 
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The most important functions of the driver 

 

Opening and closing the shutter 

To open or close the dome's shutter, press the Open or Close button in the main program 

window. If the dome has more than one shutter, a sequence of commands will be automatically 

executed to open or close individual shutters in the order 3-2-1 for opening and 1-2-3 for closing. 

The active shutter of the dome can be defined in the window Config>Shutter selecting the option 

Dome have shutter 1/2/3. 

 

Additionally, in the Shutters tab, you can issue the shutter opening command only to specified 

angle selected in the GoTo field. If the dome has more shutters, you can open or close selected 

shutter individually in this tab. 

The Reset button allows you to reset the counter or encoder of the shutter position. At the next 

sequence of opening/closing the shutter, the driver will automatically calculate the Max value 

(maximum value of the shutter position counter) - which will allow you to select the angle to 

which the shutter is to open. 

 

CW and CCW dome rotation 

After pressing these buttons the dome starts to rotate in the selected direction as long as you 

hold down the left mouse button. 

Rotating to a selected angle - GoTo 

Pressing Main>GoTo button causes the dome to rotate to the azimuth angle selected in the field 

next to the button. We can enter the angle manually or select it from the list. You can also enter a 

value, e.g. 5+ or 5, which will rotate the dome by 5 degrees from the current position. 

Additionally, we can issue commands: 

• GoTo Scope –rotation of the dome to the telescope position. 

• GoTo Home –rotating the dome to the Home Sensor position. 
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• Find Home – the dome will start rotating until it finds the Home Sensor active. 

• Park – rotation of the dome to the AtPark position defined in the window 

Config>Dome. 

• Derotate – function intended for users of domes in which the shutter is wired. It allows 

the dome to be rotated in the opposite direction to the winding power supply cable of 

the shutter. 

 

Rotating to the selected encoder position - ENC. GoTo 

In addition to rotating the dome to a given azimuth, we can rotate the dome to the selected 

encoder value. This function is useful when testing the operation of the Home Sensor, encoder 

and dome rotation motor. For example: 

1. Set the dome manually on the Home Senor (ENC: 0) - so that the Home Sensor is active. 

2. Reset the encoder counter with the button Config>Card>Dome Counters and encoder calib.> 

Reset Encoder ENC = 0. 

3. Rotate the dome several times to the ENC: 300 position and back to the ENC: 0 position. 

4. Check if the dome still hits the Home Sensor - the AtHome marker must be displayed in red. 

Synchronization of the dome with the position of the telescope - Sync with Scope 

 

Pressing the Scope OFF button will cause the dome to synchronize its position with the position of 

the telescope. Once activated, the button will change its color and description to Scope ON. Of 

course, you must first configure the X, Y, Z, Gem, PierSide parameters and enter the coordinates 

of the observatory. It is also necessary to configure the connection to the telescope. The 

telescope must be synchronized with position on the sky. 
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Sync with Sky  

 

This is a function intended for visual observation - turning it on will cause the dome to make one 

rotation every 24 hours. 

Sync with Wind 

 

Enabling this function will cause the dome to turn automatically with the shutter according to the 

direction of the wind. This is useful when strong winds are forecast that could damage the dome. 

Protection against bad weather - Weather Prot. 

 

After enabling this function, the driver will automatically close the dome and force 

synchronization with the wind direction. The function is triggered by the Bad Weather marker. 

This allows you to be sure that in the event of rainfall or too strong wind, the dome will close by 

itself, without the user's intervention. 

Finding Home position 

To find Home Sensor positions use the function GoTo>Find Home. When you select it from the 

list, a warning will be displayed that the dome may rotate outside the limits specified in 

Config>Card>Card Configuration>Encoder Max Value/ Encoder Min Value. 

  



  
Str: 32 

Restoring the driver's factory settings and saving the configuration to a file 

 

In order to restore the factory default settings of the driver: 

1. Select the type of dome and card. 

2. Press the “Save Settings” button at the bottom of the Config window. 

3. Press “Restore Default” buton. 

4. Enter the method of connection with the card from the beginning. 

Upgrade firmware - the card's firmware 

Firmware upgrade can only be done via USB connection. You should always upload the same 

software version to both cards: Dome and Shutter. 

Please see the video on the website: Facebook  

( https://www.facebook.com/1338769339600016/videos/1483129165182748 ) 

  

https://www.facebook.com/1338769339600016/videos/1483129165182748
https://www.facebook.com/1338769339600016/videos/1483129165182748
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"Bad Weather" sensor configuration (since version 5.5.29) 

The "Bad Weather" sensor is one of the most interesting functions of the driver. Its main task is to 

close the dome in case of bad weather conditions.  This function can be enabled by checking the 

"Bad Weather" option in the Config>Shutter Events>Close Shutter on driver events> window or by 

pressing the "Weather Protect" button in the main program window. 

 

The sensor status is displayed in the main program window in the Weather>Weather Condition 

Info tab: 

 

If the Bad Weather option is selected, the program checks every 6 seconds (s) whether there are 

bad weather conditions and if such a condition does not change for 10 consecutive tests (clk), the 

driver will start closing the observatory shutter. 

 

At the same time, the Observatory Unsafe status will be transmitted via the ASCOM Safety 

Monitor interface - but only when the appropriate number of tests set by the "period" and "clk" 

parameters set for the Safety Monitor have passed. 

Bad Weather sensor combines data from multiple devices:  

- weather station,  

- cloud sensor,  

- Sky Quality Meter (SQM) sensor. 

 

If ScopeDome Cloud Sensor is selected as the weather station or cloud sensor, the program will 

also take into account data from the temperature and humidity sensor connected to the card 

(ScopeDome Humidity Sensor). 

Additionally, based on the observatory coordinates provided in the driver configuration, the time 

of sunrise and sunset is calculated, which allows you to determine when night and day begin. 

In combination with the ASCOM Safety Monitor and ASCOM Observatory Condition Hub (OCH) 

modules built into the driver, this allows you to send the dome status and data from weather 

stations to other programs controlling the observation session, such as N.I.N.A., ACP. Voyager, 

SQP, and interruption depending on weather conditions. 
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The Bad Weather Sensor can be activated by: 

- rain, 

- strong wind, 

- clouds, 

- during the day (after sunrise), 

- Unsafe status sent via Cloud Sensor log (e.g. AAG), 

- Relay Switch Closed status sent via Cloud Sensor log (e.g. AAG), 

- Relay Switch Opened status sent via Cloud Sensor log (e.g. AAG), 

- too high ambient temperature, 

- too low ambient temperature, 

- too much humidity, 

- too low quality of stars sent by the Sky Quality Meter (SQM) sensor. 

The occurrence of each of these situations will activate the sensor. For example, it may be clouds 

or strong wind, or just too low temperature, if the other options are not selected. Deselecting all 

options will prevent the sensor from ever being activated. 
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 Typical card connection configurations 

ScopeDome 2M 
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ScopeDome 3M 
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ScopeDome 4M 
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ScopeDome 55M 
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ScopeDome 3M 

 

  



  
Str: 40 

RollOffRoof 
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Cloud Sensor Statistics 

The driver, if it has a cloud sensor connected, saves data on the state of the sky and builds 

statistics based on it. This allows you to keep track of the quality of the sky above the 

observatory. For the statistics to be real, the computer controlling the card in the observatory 

must be running 24 hours a day. 

Additionally in C:\ScopeDome_Driver\AllSky directory thumbnails of photos from the “All Sky” 

camera can be automatically saved. To do this, select the option Config>Weather>Archive photos 

in the AllSky subdirectory and of course, configure access to photos from the “All Sky” camera. 

 
 

To convert the values, press the button Weather>Update Statistic 

An example of statistics from the Otivar Observatory from October to the end of December 2020. 
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Additional software 

Additional utility software is installed with the driver in the Driver_LS subdirectory. Necessary shortcuts to 

these programs are installed in the Windows menu. 

Arduino_Test_App.exe 

With this program, you can fully configure all the parameters and operation of the Arduino ScopeDome 

card. It is a utility for advanced users to test and diagnose the card. It should not be used as a tool for 

operating the observatory. It will certainly be helpful for people who want to write their own card 

control software. 

In the Card tab, configure the connection parameters with the card and then press Save Settings. After 

setting the connection parameters, press the Connect button. This is the only place in the program that 

allows you to change the IP address, MAC and password to access the card. If you use several 

ScopeDome cards in one network, each of them must have a different IP address and a different MAC 

address. The default IP address saved to the card configuration is 192.168.1.120. Pressing the Get Status 

button will cause the current status of the card to be read once. The Start button causes repeated (at 

intervals set in the Card Status Reading Interval field) sending of the command selected in the 

Command field to the card. 

In the Status tab you can read the current card status. 

The Status Txt tab displays the answer from the card in a clearer way, broken down into sections. 

The Thermometers tab is used to configure the operation of the card's thermometers and thermostats. 

The Emergency Shutter Close tab allows for advanced configuration of emergency shutdown conditions 

of the dome shutters. 

 

Changing the IP and MAC address of the card 

The new IP or MAC address should be entered after the field Card>Ip address, then press the 

Save Settings button. 

 

Turning on selected thermometers 

 

With these options, you can enable or disable all or only selected thermometers on the card. The 

Board option allows you to select the card you want to program (Dome or Shutter). Master 
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Preset and Slave Preset options are used to restore the typical ScopeDome driver settings of the 

card. 

Activating selected thermostats 

 
Clear All disables all thermostats on the selected tab. 

The thermostat, based on the temperature, pressure or humidity read from the selected 

thermometer, can turn on or off the selected relay depending on whether the set temperature 

has been reached (Set On ˚C field). In other words, it enables, for example, the heating of a 

telescope's motor or mirror to a preset temperature, of course if a heater is connected to the 

selected relay. An interesting feature is the ability to turn on the heating depending on the value 

of a different thermometer - it allows, for example, to heat the telescope's mirrors by 2 degrees 

above the ambient temperature. 

 

 

Note: Pushing the "Send Config to card" button in the ScopeDome driver will overwrite all 

changes made with this program, except the card's IP address. 
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ScopeDome_Test_And_Config.exe 

 

With this program you can: 

• Perform a random rotation and dome opening test. 

• Configure the card in a situation when the card driver freezes after the changes made 

by the user. 

Random test of dome operation 

To run the test: 

1. Press button ASCOM>Connect 

2. Enter the range of rotation angles  Demo Parameters>GoTo Range From / To 

3. Check the option Demo/Test Mode 

 

Emergency launch of the Config window 

After starting the program, press the button ASCOM>Config 


